DOWNLOAD PDF MACHINE GENERATED CONTENTS NOTE: BIRTH OF
THE 6
Chapter 1 : How to: View Certificates with the MMC Snap-in | Microsoft Docs
Note: Citations are based on reference standards. However, formatting rules can vary widely between applications and
fields of interest or study. The specific requirements or preferences of your reviewing publisher, classroom teacher,
institution or organization should be applied.

Statistical machine translation Statistical machine translation tries to generate translations using statistical
methods based on bilingual text corpora, such as the Canadian Hansard corpus, the English-French record of
the Canadian parliament and EUROPARL , the record of the European Parliament. Where such corpora are
available, good results can be achieved translating similar texts, but such corpora are still rare for many
language pairs. Generally, the more human-translated documents available in a given language, the more
likely it is that the translation will be of good quality. With further development, this may allow statistical
machine translation to operate off of a monolingual text corpus. In this approach, the corpus that is used is one
that contains texts that have already been translated. Given a sentence that is to be translated, sentences from
this corpus are selected that contain similar sub-sentential components. Hybrid machine translation Hybrid
machine translation HMT leverages the strengths of statistical and rule-based translation methodologies. The
approaches differ in a number of ways: Rules post-processed by statistics: Translations are performed using a
rules based engine. Statistics guided by rules: Rules are used to pre-process data in an attempt to better guide
the statistical engine. Rules are also used to post-process the statistical output to perform functions such as
normalization. This approach has a lot more power, flexibility and control when translating. It also provides
extensive control over the way in which the content is processed during both pre-translation e. More recently,
with the advent of Neural MT, a new version of hybrid machine translation is emerging that combines the
benefits of rules, statistical and neural machine translation. The approach allows benefitting from pre- and
post-processing in a rule guided workflow as well as benefitting from NMT and SMT. The downside is the
inherent complexity which makes the approach suitable only for specific use cases. One of the proponents of
this approach for complex use cases is Omniscien Technologies. Neural machine translation A deep learning
based approach to MT, neural machine translation has made rapid progress in recent years, and Google has
announced its translation services are now using this technology in preference to its previous statistical
methods. Tilde is also providing translation solutions based in neural networks. The broken Chinese sentence
sounds like "there does not exist an entry" or "have not entered yet" Main articles: Word sense disambiguation
and Syntactic disambiguation Word-sense disambiguation concerns finding a suitable translation when a word
can have more than one meaning. The problem was first raised in the s by Yehoshua Bar-Hillel. They can be
approximately divided into "shallow" approaches and "deep" approaches. Shallow approaches assume no
knowledge of the text. They simply apply statistical methods to the words surrounding the ambiguous word.
Deep approaches presume a comprehensive knowledge of the word. So far, shallow approaches have been
more successful. Why does a translator need a whole workday to translate five pages, and not an hour or two?
There are ambiguities one has to resolve. For instance, the author of the source text, an Australian physician,
cited the example of an epidemic which was declared during World War II in a "Japanese prisoner of war
camp". Was he talking about an American camp with Japanese prisoners or a Japanese camp with American
prisoners? The English has two senses. A shallow approach which simply guessed at the sense of the
ambiguous English phrase that Piron mentions based, perhaps, on which kind of prisoner-of-war camp is more
often mentioned in a given corpus would have a reasonable chance of guessing wrong fairly often.
Non-standard speech[ edit ] One of the major pitfalls of MT is its inability to translate non-standard language
with the same accuracy as standard language. Heuristic or statistical based MT takes input from various
sources in standard form of a language. Rule-based translation, by nature, does not include common
non-standard usages. This causes errors in translation from a vernacular source or into colloquial language.
Limitations on translation from casual speech present issues in the use of machine translation in mobile
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devices. Related to named entity recognition in information extraction. Name entities, in narrow sense, refer to
concrete or abstract entities in the real world including people, organizations, companies, places etc. The
initial difficulty that arises in dealing with named entities is simply identifying them in the text. Consider the
list of names common in a particular language to illustrate this â€” the most common names are different for
each language and also are constantly changing. Another way to deal with named entities is to use
transliteration instead of translation, meaning that you find the letters in the target language that most closely
correspond to the name in the source language. There have been attempts to incorporate this into machine
translation by adding a transliteration step into the translation procedure. However, these attempts still have
their problems and have even been cited as worsening the quality of translation. For example, for "Southern
California" the first word should be translated directly, while the second word should be transliterated.
However, machines would often transliterate both because they treated them as one entity. Words like these
are hard for machine translators, even those with a transliteration component, to process. The lack of attention
to the issue of named entity translation has been recognized as potentially stemming from a lack of resources
to devote to the task in addition to the complexity of creating a good system for named entity translation. One
approach to named entity translation has been to transliterate, and not translate, those words. A second is to
create a "do-not-translate" list, which has the same end goal â€” transliteration as opposed to translation. A
third approach to successful named entity translation is a class-based model. In this method, named entities are
replaced with a token to represent the class they belong to. For example, "Ted" and "Erica" would both be
replaced with "person" class token. In this way the statistical distribution and use of person names in general
can be analyzed instead of looking at the distributions of "Ted" and "Erica" individually. A problem that the
class based model solves is that the probability of a given name in a specific language will not affect the
assigned probability of a translation. A study by Stanford on improving this area of translation gives the
examples that different probabilities will be assigned to "David is going for a walk" and "Ankit is going for a
walk" for English as a target language due to the different number of occurrences for each name in the training
data. A frustrating outcome of the same study by Stanford and other attempts to improve named recognition
translation is that many times, a decrease in the BLEU scores for translation will result from the inclusion of
methods for named entity translation. Using these methods, a text that has been translated into 2 or more
languages may be utilized in combination to provide a more accurate translation into a third language
compared with if just one of those source languages were used alone. If the stored information is of linguistic
nature, one can speak of a lexicon. With access to a large knowledge base, systems can be enabled to resolve
many especially lexical ambiguities on their own. In the following classic examples, as humans, we are able to
interpret the prepositional phrase according to the context because we use our world knowledge, stored in our
lexicons: With a large enough ontology as a source of knowledge however, the possible interpretations of
ambiguous words in a specific context can be reduced. Other areas of usage for ontologies within NLP include
information retrieval , information extraction and text summarization. Because of its size, it had to be created
automatically. A definition match algorithm was created to automatically merge the correct meanings of
ambiguous words between the two online resources, based on the words that the definitions of those meanings
have in common in LDOCE and WordNet. Using a similarity matrix , the algorithm delivered matches
between meanings including a confidence factor. This algorithm alone, however, did not match all meanings
correctly on its own. A second hierarchy match algorithm was therefore created which uses the taxonomic
hierarchies found in WordNet deep hierarchies and partially in LDOCE flat hierarchies. This works by first
matching unambiguous meanings, then limiting the search space to only the respective ancestors and
descendants of those matched meanings. Thus, the algorithm matched locally unambiguous meanings for
instance, while the word seal as such is ambiguous, there is only one meaning of "seal" in the animal
subhierarchy. Both algorithms complemented each other and helped constructing a large-scale ontology for
the machine translation system. Applications[ edit ] While no system provides the holy grail of fully automatic
high-quality machine translation of unrestricted text, many fully automated systems produce reasonable
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output. Probably the largest institutional user is the European Commission. In-Q-Tel [49] a venture capital
fund, largely funded by the US Intelligence Community, to stimulate new technologies through private sector
entrepreneurs brought up companies like Language Weaver. Currently the military community is interested in
translation and processing of languages like Arabic , Pashto , and Dari. Machine translation applications have
also been released for most mobile devices, including mobile telephones, pocket PCs, PDAs, etc. Due to their
portability, such instruments have come to be designated as mobile translation tools enabling mobile business
networking between partners speaking different languages, or facilitating both foreign language learning and
unaccompanied traveling to foreign countries without the need of the intermediation of a human translator.
Despite being labelled as an unworthy competitor to human translation in by the Automated Language
Processing Advisory Committee put together by the United States government, [52] the quality of machine
translation has now been improved to such levels that its application in online collaboration and in the medical
field are being investigated. The application of this technology in medical settings where human translators are
absent is another topic of research, but difficulties arise due to the importance of accurate translations in
medical diagnoses. Evaluation of machine translation There are many factors that affect how machine
translation systems are evaluated. These factors include the intended use of the translation, the nature of the
machine translation software, and the nature of the translation process. Different programs may work well for
different purposes. In certain applications, however, e. Even though human evaluation is time-consuming, it is
still the most reliable method to compare different systems such as rule-based and statistical systems. It is
certainly true that even purely human-generated translations are prone to error. Therefore, to ensure that a
machine-generated translation will be useful to a human being and that publishable-quality translation is
achieved, such translations must be reviewed and edited by a human. Such research is a necessary prelude to
the pre-editing necessary in order to provide input for machine-translation software such that the output will
not be meaningless. Both example-based and statistical machine translation rely on a vast array of real
example sentences as a base for translation, and when too many or too few sentences are analyzed accuracy is
jeopardized. Researchers found that when a program is trained on , sentence pairings, accuracy actually
decreases. Ana Nino of the University of Manchester has researched some of the advantages in utilizing
machine translation in the classroom. One such pedagogical method is called using "MT as a Bad Model. Nino
cites that this teaching tool was implemented in the late s. At the end of various semesters, Dr. Nino was able
to obtain survey results from students who had used MT as a Bad Model as well as other models.
Overwhelmingly, students felt that they had observed improved comprehension, lexical retrieval, and
increased confidence in their target language. Machine translation of sign languages In the early s, options for
machine translation between spoken and signed languages were severely limited.
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Machine generated contents note: Chapter Machine generated contents note: Chapter ipad Once the data is
downloaded to your machine, you can load some of it using the Python interpreter. The first step is to type a
special command at the Python prompt which tells the interpreter to load some texts for us to explore: A
Turing machine is a mathematical model of computation that defines an abstract machine, which manipulates
symbols on a strip of tape according to a table of rules. The machine operates on an â€¦ download Machine
generated contents note: Chapter in ePub ebook Machine generated contents note: Chapter epub download
Compiled code to be executed by the Java Virtual Machine is represented using a hardware- and operating
system-independent binary format, typically but not necessarily stored in a file, known as the class file format.
The class file format precisely defines the representation of a class or interface, including details such as byte
ordering that â€¦ download Machine generated contents note: Chapter azw download A breadboard is a
construction base for prototyping of electronics. Originally it was literally a bread board, a polished piece of
wood used for slicing bread. In the s the solderless breadboard a. Because the solderless breadboard â€¦
Domain membership is a subject of vital concern. Samba must be able to participate as a member server in a
Microsoft domain security context, and Samba must be capable of providing domain machine member trust
accounts; otherwise it would not be able to offer a viable option for many users. This document specifies an
abstract machine. It does not describe any particular implementation of the Java Virtual Machine. Chapter kf8
download read Machine generated contents note: Chapter ebook download download Machine generated
contents note: Chapter in pdf Chapter Objectives. Confessions of a Nuclear War Planner and millions of other
books are available for instant access. Kindle Audible download Machine generated contents note: Chapter
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Microsoft Word makes the creation of a TOC easier by allowing you the option of creating a TOC without
using styles and by allowing you to mark a single word or group of words in a particular body of text and add
that information to the TOC. A TOC can be generated by using the Lead-in Emphasis feature to apply heading
styles to any lead-in text the first word or words in a paragraph or sentence. By using the Lead-in Emphasis
feature, you can create paragraphs where the first portion of the paragraph is formatted with a heading style
and appears in the TOC, but the rest of the paragraph is normal text and does not appear in the TOC. This
article describes how to use this new feature to create a TOC. Create Table of Contents In Word, you can
create a TOC based on a portion of the text in a paragraph without including the whole paragraph. You can
mark text by using the Lead-in Emphasis feature with heading styles to include the text in a TOC. To insert a
table of contents, follow these steps: Start Word, and then open your document. Click an empty paragraph
where you want to insert the TOC. On the Insert menu, point to Reference, and then click Index and Tables.
Then, click Insert Table of Contents. Note If the text that is contained in your document is not marked to be
included in a TOC, you receive the following error message in your document instead of the TOC: No table of
contents entries found. Use one or more of the following methods to mark text that you want to include in the
TOC. In the following paragraph, if you want to include the introductory words "Widow and Orphan" in your
TOC, just select these words, and then continue with the steps. A widow is the last line of a paragraph printed
by itself at the top of a page. An orphan is the first line of a paragraph printed by itself at the bottom of a page.
Click the drop-down arrow in the Style box on the Formatting toolbar, and then select the heading that you
want. Because no hidden paragraph markers or other items are used, the whole process is seamless. Word uses
a new underlying feature named "Linked character styles" to do this. The heading style applied to the lead-in
portion of the document is displayed as a heading style, but it is actually a linked character style. In Word and
later, when you apply a paragraph style to a subset of paragraph, the following behavior occurs: A hidden
character style is created that takes the same character properties as the paragraph style being applied. The
character style is applied to the selection. The hidden character style created with linked character styles
appears in the Style drop-down list if the document is opened and viewed in earlier versions of Word. The
functionality of the style separator is lost if the document is saved in an earlier version of Word. To view the
hidden character style, follow these steps: On the Format menu, click Reveal Formatting. The Reveal
Formatting task pane appears. Click the Styles dialog box launcher in the Styles group on the Home tab. In the
Styles window, click Style Inspector. Select the text in your document and notice that exact formatting details
appear in the Reveal Formatting task pane. Select the text that has the character style applied and note that the
text appears as a character style in the Reveal Formatting task pane. The linked style appears as Heading Char
in the Reveal Formatting task pane. The actual character style remains hidden in the Styles and Formatting
task pane or the Style drop-down list on the Formatting toolbar. Any paragraph style can be used for the linked
character style. A paragraph style can be created that looks exactly like the body text paragraph style, and then
applied to a portion of a paragraph. In this manner, the text that is used to build the TOC can exactly match the
text in the paragraph, assuming the TOC options are modified to include the style for the lead-in text. Style
separator tags allow you to do the following: Apply heading styles to a single word or phrase in a paragraph so
that only that word or phrase appears in the TOC. Include two styles in a single paragraph so that the lead-in
paragraph appears in the TOC. Apply outline levels to lead-in text so that only the lead-in text appears in the
TOC. Apply outline levels to a single word or phrase in a paragraph so that only that word or phrase appears
in the TOC. The style separator is a hidden paragraph mark that serves as a delineator between separate styles
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applied in a document. To make the style separator mark visible, follow these steps: On the Tools menu, click
Options. On the View tab, click All under Formatting Marks. Before you can use the Style Separator feature,
you must add the Style Separator button to your toolbar: Click Customize on the Tools menu. Click the
Commands tab, and then click All Commands in the Categories list. Click the Microsoft Office button, and
then click Word Options. In the Choose commands from list, click All Commands. Insert the style separator
before you apply the heading style to your text. To do this, use one of the following methods. As you type, and
you reach a word or phrase in a paragraph that you want to include in the TOC, click the Style Separator
button. When you click the Style Separator button, the insertion point moves to the right of the separator so
that you can continue typing. Type the word or phrase that you want to include in the TOC, and then click the
Style Separator button again. Select the word or phrase that you want to include in the TOC, click the
drop-down arrow in the Style box on the Formatting toolbar, and then select the heading that you want. The
word or phrase between the two style separators appears in the TOC. Insert the Style Separator between two
existing paragraphs: You can use the style separator between two existing paragraphs so that the first
paragraph becomes the lead-in text and appears in the TOC, and the second paragraph is the remainder of the
text and does not appear in the TOC. To do this, follow these steps: Create two paragraphs of text, placing text
that you want to appear in the TOC in the first paragraph, the remainder of the text in the second paragraph.
Position the insertion point in the first paragraph, and then click the Style Separator button. The two
paragraphs appear to become a single paragraph by converting the paragraph mark at the end of the first
paragraph to a style separator. You now have a single compound paragraph, which shows up as two separate
paragraphs in Outline view, but which prints as a single paragraph. Select the text to the left of the separator,
click the drop-down arrow in the Style box on the Formatting toolbar, and then select the heading that you
want. The TOC displays only the lead-in portion the first paragraph formatted with the heading style. The
style separator is a special form of a hidden paragraph mark. Therefore, documents with style separators that
are created in Word and in later versions of Word appear the same in Word and in Microsoft Word 97 unless
you click All under Formatting Marks. If you click All under Formatting Marks in earlier versions of Word,
the style separator hidden paragraph mark appears as a normal paragraph mark, and the document will be
repaginated. When you use an earlier version of Word to view documents that have style separators that were
created in Word and in later versions of Word, do not click All under Formatting Marks. Removing a Heading
from the Table of Contents If you want to remove a heading from the TOC, you can apply a new paragraph
style to the marked text: Select the marked text, click the drop-down arrow in the Style box on the Formatting
toolbar, and then select the heading that you want. Click Normal to remove the heading style. By applying the
paragraph style that you want to the whole paragraph, you do not remove the style. You must select the exact
text as it appears in the TOC, and then apply the new style. References For more information about how to
create a table of contents without changing the formatting of your text, click the following article number to
view the article in the Microsoft Knowledge Base:
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When creating secure services or clients, you can specify a certificate be used as the client or service
credential by using methods such as the SetCertificate method. The method requires various parameters, such
as the store where the certificate is stored and a value to use when searching for the certificate. The following
procedure demonstrates how to examine the stores on a computer to find an appropriate certificate. For an
example of finding the certificate thumbprint, see How to: Retrieve the Thumbprint of a Certificate. Note that
to view certificates in the local machine store, you must be in the Administrator role. In the Add Standalone
Snap-in dialog box, select Certificates. In the Certificates snap-in dialog box, select Computer account and
click Next. Optionally, you can select My User account or Service account. If you are not an administrator of
the computer, you can manage certificates only for your user account. In the Select Computer dialog box, click
Finish. In the Add Standalone Snap-in dialog box, click Close. In the Console Root window, click Certificates
Local Computer to view the certificate stores for the computer. To view certificates for your account, repeat
steps 3 to 6. In step 7, instead of selecting Computer account, click My User account and repeat steps 8 to On
the File menu, click Save or Save As. Save the console file for later reuse. Viewing Certificates with Internet
Explorer You can also view, export, import, and delete certificates by using Internet Explorer. Click the
Content tab. To view details of any certificate, select the certificate and click View.
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William was a Church of England priest who had been a missionary overseas before returning to England as a
country vicar , eventually becoming archdeacon of Bristol. Elizabeth was the daughter of another priest, the
Revd Edward Moule Griffith. He was one of four early recruits the others being Alan Turing , Hugh
Alexander and Stuart Milner-Barry , who all made significant contributions at Bletchley and who became
known as "the wicked uncles". They were also the four signatories to an influential letter, delivered to Winston
Churchill in October , asking for more resources for the code-breaking work at Bletchley Park. Churchill
responded with one of his "Action This Day" written comments. As stated in his book, most of his work at
Bletchley was centred on what was known as "traffic analysis" of encrypted German communications. Most
cryptographers agree this is markedly easier than attacking cryptographic ciphers directly although still very
complicated and mathematically intensive processing is needed to make initial discoveries , and Welchman is
credited with innovating the approach. This led to data analysis techniques that today we describe as metadata
analysis. If 26 rows of 26 way connectors are stacked up, then any connection point can be referenced by its
row letter and column letter. A physical piece of wire can now connect row B element G to row G element B.
The device was called a Diagonal Board because such a piece of wire is diagonally across the matrix of
connections. The Diagonal Board cut decipher times down from days to mere hours when attacking ciphers
generated by the German Enigma machine. Bombes became the primary mechanical aid in breaking Enigma
ciphers during the war, by speeding up the search for current wheel order settings being used with the Enigma
machines. Wheel order settings were changed often, initially at least once per day. He followed this by
employment with Remington Rand and Ferranti. In that year, he joined the Mitre Corporation , working on
secure communications systems for the US military. He retired in , but was retained as a consultant. The
National Security Agency disapproved. The book was not banned, but Welchman lost his security clearance
and therefore his consultancy with MITRE and was forbidden to discuss either the book or his wartime work.
The couple had a son and two daughters. The marriage lasted until Speaking at the event, the Director of
GCHQ Robert Hannigan acknowledged the harsh treatment of Welchman and paid tribute to his "immense
contribution" as a "giant of his era" [12].
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using the Python interpreter. The first step is to type a special command at the Python prompt which tells the interpreter
to load some texts for us to explore: from calendrierdelascience.com import *.This says "from NLTK's book module, load
all.
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(6) An assessment of the newborn's condition immediately after birth, including time and date of birth, vital signs, birth
weight and length, head and chest measurements, general appearance and physical findings.
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